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t is a pleasure to see this book
come to fruition. With the introduction of the Apple® Macintosh™
computer in 1984, there was an attempt to bring some advanced
technology to the marketplace at a relatively low price. Among the
technological features of this device were a high-resolution screen, the
use of a mouse for cursor movement and for selecting actions, and the
use of visual images (icons) to help guide the user.

Uniqueness of Macintosh Pascal

With the release of Apple’s Macintosh Pascal software, an interactive
environment for the programming language Pascal also became
available. Most earlier implementations of Pascal had used the compiler
technology to implement programs. With an interactive interpreter for
running Pascal programs, there came the ability to step through a
program as it was being run and to obtain almost instant information on
its status. In this way a Pascal program could take on a life of its own. The
programmer could in some sense “see” the program running. For us,
using and teaching these aspects has been a pleasure.

All of this technology though was not without another deliberate
design goal—ease of use. It has often been the case that programming
language implementations have been heaped in a technology of
complicated command languages and conventions that programmers
need to follow. With the Macintosh and its Pascal, this was clearly not the
case. Human engineering was paramount.

General Goals

The most visible goal of this book is to help teach the uninitiated to
program in Macintosh Pascal. In this matter this book follows traditional
lines. The book introduces the mechanics of using the Macintosh Pascal
system, introduces the reader to some simple programs, and then
presents a systematic development of the concepts in Pascal. These
concepts include syntax, assignment, control structures, data types,
procedures, and so on.
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Preface

In many ways this book follows the CS 1 course of the Association
for Computer Machinery’s curriculum '78. The goals of CS 1 (see
Communications of the ACM, October 1984) are (1) to teach methods of
problem solving and the writing of algorithms, (2) to teach a particular
high-level programming language, (3) to teach programming techniques
and methods of style that promote quality. These are certainly the goals
in this book.

But this book was also written out of a bit of frustration. I have seen
too many books on programming that tend to drag the reader on with an
almost exclusive reliance on the syntax of the programming language.
Authors tend to think that once the syntax is understood, the rest will
follow in due course. This usually leads to an overemphasis on the
technical aspects of the programming language, a reliance on syntax
equations for teaching, a tendency toward sterile examples, and a
general lack of understanding of the deeper issues of programming.

This book is not at all traditional in these aspects. The examples,
ideas, and presentation issues in this book have evolved over several
years. They have been given a great deal of thought. The hope has been
to spark attention and enthusiasm and to motivate excellent work.

Motivation through Problems

At the outset, the design of this book is based on problems, programming
problems. It is my belief that programming is understood best when the
solving of problems drives the learning process. It is the problems here
that introduce the need for a given Pascal construct. These problems
have been chosen to help the reader think about programming.
Technical details, such as the syntax and semantics of Pascal, are
introduced following the problem that motivates their need. After all,
ultimately a programming language is used to solve real problems.

Thoughtful Examples

Another philosophy is teaching through examples. An astute and
experienced programmer is often guided by many general concepts that
come into play at various stages of the programming process. But the
student of programming is in a different position. The student must,
somehow, discover these concepts. The dilemma is that teaching
programming through syntax masks the greater principles involved, but
teaching through general concepts often leaves the student at sea in an
attempt to understand what the concepts truly imply. So, the approach
here is to make frequent use of examples. The examples guide both the
teaching of syntax and concepts.



Preface

xvii

Practice Sessions

The student of programming must also face the task of his or her own
work. This can be a sizable jump, from talk to action. For this purpose,
there are special sections at the end of each chapter called “Practice.”
These are not appendages, but part of the text. They attempt to go into
detail and challenge the reader to respond. All kinds of issues are
addressed in these drills: syntax, finding bugs, the effect of removing
parentheses, whether 5.0 can be changed to 5, using pointers, type
declarations, using conditions, and more. The goal is to explore the fine
print and involve the reader in an active way.

Following the practice sections, each chapter concludes with a
selection of programming exercises. These are to be done on the
computer. An attempt has been made to avoid toy exercises in favor of
more real life problems.

Book Structure

In the structure of this book each chapter or sequence of chapters
follows a somewhat general pattern:

1. Motivation

2. Example

3. Technical details
4. Practice

The motivation sections of this book are short Sherlock Holmes
dialogues taken from a previous work (Elementary Pascal, by Henry
Ledgard and Andrew Singer, published jointly by Random House and SRA
(student edition), 1982). In each of these dialogues, Sherlock Holmes (the
teacher) and Watson (the student) attempt to solve some kind of
programming problem. In the course of the narrative, some basic
programming principles are presented in an easily readable form. An
example, a Macintosh Pascal program embodying the solution to the
problem, is presented after each narrative. Then come the techrical
details, a discussion of the syntax and meaning of features in Pascal. Here
the rules of Macintosh Pascal are given and concepts like type
declarations and punctuation rules are explored at great depth. These
technical matters comprise the bulk of this book. Following these
sections are the practice sections.

Reaching Toward Real Programming
The last chapter of this book concludes with a program of some
reasonable scale, a program to perform text formatting and layout.
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Preface

Writing programs like this is not easy for the student, especially the first-
time student of programming. But this, in a nutshell, is the objective here:
to understand Pascal with sufficient depth to reach the level of
programming in the last chapter.

A Spirit of Lightness

The Sherlock Holmes dialogues reproduced here from an earlier general
text on Pascal have been slightly edited for compatibility with Macintosh
Pascal. I think it is fair to say that they give a lightness and spirit to an area,
computer programming, that is often rather dryly presented. But the
dialogues have an even deeper purpose: to make the reader think about
programming. As in any discipline, some ideas in programming are more
important than others. It is these ideas that are presented in the
narratives. Thus separated from the technical details of our profession,
the fundamental ideas remain simple and readable.

Acknowledgments
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This book is about program-
ming. It is meant to teach a person with little computer experience how to
write computer programs. The programming language is Macintosh
Pascal.

Users of a professionally designed software system like the
Macintosh Pascal system expect it to be free of strange quirks. We expect
it to be error free, easy to use, and consistent. We expect the computer to
respond rapidly. In order to achieve such professional results, many
persons are involved. They have to work together, to read each other’s
programs, to learn what makes one solution to a problem better than
another, to think about new releases of software and new features that
might be needed. All of this implies that programming is not only a
technical activity, but a human activity.

Let us now take a look at the “amateur” programmer, one who
probably enjoys programming and most likely works alone. The
programs do not have to be sold by Apple; most likely the author is the
only one to use them. They don’t even have to work properly all the time,
for the amateur can grow to understand and tolerate any shortcomings
that a program might have. An amateur’s programs are relatively small
(although occasionally some large ones are written). They usually don’t
have to fit with other software that someone else may have written. They
just have to work, so to speak, most of the time and do something that is
fairly useful. It is not the concern of the amateur to write something like
the software required for a commercial word processor or a drawing
package for children. The world of the amateur is thus quite self-
contained.

If something goes wrong, the amateur can probably fix the program
easily. Since only one person has written it and probably understands it
quite completely, making corrections is a relatively simple chore. As for
its behavior when it is run, it doesn’t really matter whether the input
conventions are convenient or whether the display is pleasant to read.
Since no one but the program’s designer depends on the program, it
probably doesn’t even need any documentation to reveal how it works. In
short, it’s a solo flight.

But now let us look again at the professional. The task of a
professional programmer is very different from the amateur’s task. The

xix
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To The Reader

biggest difference is that the program may be used by thousands upon
thousands of people. This poses some very stringent requirements. First
of all the program had better do something useful or no one will use it or
buy it. It is not enough to do the job halfway: a complete task has to be
accomplished. The program should work just the way a user would
expect it to under all sorts of circumstances. You can bet that all sorts of
unusual inputs will eventually be tried. This means the demands on
program correctness can be enormous.

Importantly, a professional programmer must work with many
other people during the creation of a program. It is not enough for the
program to be a private matter between the programmer and the
computer. Other people have to deal with this program in intimate ways.
Someone else may need to document how the program works. Another
person may be called upon to make a change to the program. The
program may be large enough so that a whole team of programmers is
required to create it and these people must collaborate in intricate ways.
The professional certainly does not stand alone.

On top of this, the professional’s program may be used for many
years, often long after its author has any interest in the program and,
usually, after the program’s author has moved on to other things. It is
quite normal for other people, other programmers that is, to take over
the work. Imagine looking at hundreds of pages of a program written by
someone else. How would you deal with such a program? What if it is
poorly written? What if your taking over is vital to the completion of a
project? In the real world, this happens! Even something simple, like how
the program is laid out on pages of paper, may be critical to someone
else. The professional programmer annotates a program with comments
describing how it works. To be really useful the comments must be
accurate, brief, and informative. This itself is no easy task. And down to
the nitty gritty, a programmer has to use names for things in a program. It
is not enough to think of names haphazardly, for the meaning needs to
stand out to the human reader.

Even something as fundamental as understanding the problem itself
is an issue for the professional. It is not enough to conceive what the
problem is in broad terms, the professional must spell it out. Ideally a
complete written description of what the program is to do should be
stated beforehand. This should even include the form in which data is
entered by the user, and the exact layout on the screen of any results.
The professional can spend an enormous amount of time just trying to
understand this one aspect of software.

You see, professional programming is not a simple activity. It is
systematic; it is disciplined; it has a large human element. It can be tiring
at times to work this way and to take into account the myriad aspects that
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must be brought into play, but the goal is always the same: a program that
is a pleasure to read, update, run, and most important, to use.

In the chapters that follow you will be introduced to the world of
Macintosh Pascal and programming in this language. The goal in writing
this book is to try to give you the very best ideas we can about this
subject.
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Nanincoherent and, as [ deeply feel, an entirely inadequate

fashion, I have endeavoured to give some account of the

.. remarkable career of Mr. Sherlock Holmes as a criminal

investigator and consulting detective. As the reader is

undoubtedly well aware, my companion’s interests were as broad as

Nature herself and he often spoke on an amazing variety of subjects as

though he had made a special study of each. In my modest chronicles of

the cases that | have had the privilege to share with Sherlock Holmes, |

have often alluded to his numerous publications, but I have said nothing

before of his unparallelled contributions to the development of the
Analytical Engine.

My first introduction to the Analytical Engine was in the late spring,
shortly after the conclusion of one of the most ghastly adventures we had
ever shared, which | have chronicled under the heading of “The
Adventure of the Speckled Band.” The entire day Holmes was in a mood
that some would call taciturn. He was most unsettled, smoked
incessantly, played snatches on his violin, sank into reveries, and hardly
answered the casual questions that I put to him. We sat through a silent
dinner together, after which, pushing his plate aside, he revealed to me
the problem with which he was preoccupied.

“You can never foretell what one mind will come up with, Watson,
but you can say with precision what an average person will do.
Individuals vary, but percentages remain constant; and while we have not
yet grasped the results that the human mind alone can attain, it has its
distinct limitations. There are only particular individuals on whom we can
rely to produce the same chain of logical argument from one occasion to
the next.”

“I certainly wouldn’t argue with you, Holmes,” I replied. “But as yet
we haven't found a suitable replacement for human reasoning.”

“Oh, on the contrary, Watson,” he answered nonchalantly. “Have
you ever heard of the Analytical Engine?”

“I know of no substitute for the mind of man.”
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“Have you ever heard of the Analytical Engine?”

Holmes chuckled. “Then you must learn of it. It is an ingenious
mechanism, a machine that has displayed a considerable talent for
deductive reasoning, far superior to the average logician. You recall my
intervention in the matter of that notebook floating in the River Cam last
month?”

“I am not likely soon to forget the sight of that bloated face staring
up at me, Holmes,” | replied grimly, considering the sorry state of
mankind that such events should come to pass. “What connection has
the late professor with this Engine?”

“Well, as you may remember, my investigation led me to the
Cavendish laboratories; and it was there that | had occasion to study the
Engine, if only briefly. Since then | have been in correspondence with
mathematicians at Cambridge who have been conducting experiments
with it. Watson, I do not exaggerate when I say that the Analytical Engine
is capable of solving, within minutes, complex numerical problems that
would keep five of London’s finest mathematicians working for hours.
Furthermore, it is adept at logic and has a perfect memory for detail.
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“The Engine also has its limits,” he continued. “It can only
undertake problems whose solutions are spelled out in minute detail and
that are presented in its own peculiar language.”

“Really, Holmes, sometimes you go too far with my patience!” I
exclaimed. “You expect me to believe that this device is capable of
solving problems, has a perfect memory, and actually speaks a language
of its own?”

“No, no, my dear Watson, you take me too literally. The Analytical
Engine does indeed have a language of its own, but communications must
be written out.”

“Now you tell me it can read?”

“In a sense, yes.”

[ threw up my arms in a desperate gesture and began to rise from
the table.

“I fear I am going too fast for you, Watson. Bear with me for a
moment and I shall do my utmost to explain all this to you. Everything I
say is true, but let me assure you that the Analytical Engine hardly
resembles a human being.

“Its ‘language’ is actually a highly logical code, designed by
mathematicians in order to operate the Engine. This code is not difficult
to master, but it does require considerable discipline. It has a very small
vocabulary, which is nothing to compare with the English tongue. This
vocabulary is arranged into statements according to a limited set of
rules.

“The major problem in communicating with the Engine is that one
must use the utmost care and precision in giving it instructions, for it has
no imagination whatsoever and cannot correct even trivial errors in
spelling or punctuation. It is, after all, like other machines in that it has no
awareness of the tasks that it performs; therefore it will obey the most
unreasonable of instructions. For example, if it is told to print the number
zero ad infinitum, it will continue to do so for hours on end, until a human
being finally causes it to stop.”

“But Holmes, how does one give instructions to this Engine?” |
asked, scarcely crediting my companion’s remarks thus far and
wondering whether perhaps his penchant for cocaine had finally
betrayed his reason.

“By writing a set of instructions in code and supplying them
mechanically to the Engine. Such a set of instructions is called a
programme, because it is an orderly and precise procedure for solving a
problem. The art of writing programmes is called, reasonably enough,
programming.”

“Of what relevance is this strange machine to you, Holmes?”

“I intend to employ the Engine whenever possible in my future
criminal cases,” he replied. “As you know, I have been rather
overburdened with work in recent months, so the Engine’s speed and
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potential accuracy are most attractive to me. It has a great capacity for
dealing with large amounts of information as well.”

“But, Holmes,” | interrupted, “do you truly expect this device, if it is
as unimaginative as you say, actually to solve crimes?”

“Not at all, my dear Watson,” said Holmes with a laugh. “I daresay it
is not clever enough to replace my brain; but it will be useful for storing
information, as well as for performing certain repetitive tasks that absorb
too much of my time. Of most interest to me is that it will provide a means
of expressing my logical methods in a rigorous form, and perhaps be
useful in communicating to others my modest attempts at formulating a
Science of Deduction.”




Chapter 1

The Analytical Engine was
indeed the forerunner of today’s computers. In the 1830s Charles
Babbage and his collaborator, Lady Augusta Ada Lovelace (Lord Byron’s
daughter), between them worked out most of the fundamental principles
upon which modern computing is based.

Holmes'’s insight into the promises and pitfalls of the computer (in
the Prelude to this chapter) is striking. The ability to handle great
amounts of data, to remember even the tinest detail, to make extremely
accurate calculations, and to obey instructions over and over again are
all well recognized.

What are not so well recognized are the pitfalls: the often endless
details, the computer’s intolerance of error, the annoying idiosyncracies,
and the need for unremitting rigor.

A first attempt at programming is likely to be a frustrating
experience. The demanding precision to which Holmes alludes is quite
unfamiliar to most people. You struggle to piece together a variety of
computer instructions, making changes almost randomly and hoping
somehow the program will work. You might put a line into your program
that says,

Print the answer

and expect the computer to print the correct result. This would be futile.
To get a computer to do your bidding, you must tell it precisely what you
want it to do in exactly the proper way.

When you do this, you have at your command a kind of modern
genie. For example, the manuscript for this book was typed on the Apple
Macintosh using Apple’s MacWrite™. MacWrite makes it easy to modify
the text in small and large ways and then print out revised versions
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quickly for study and further improvement. When the revisions are
finished and the manuscript complete, the text can be transferred to
another computer which reproduces it in a form that makes it possible to
typeset the book automatically. Babbage would be especially satisfied if
he were alive today, for it was his desire to eliminate error from tide tables
that led him to develop the Difference Engine from which the Analytical
Engine evolved. In fact, this early computer was designed to set type to
enable the printing of the tables.

In the chapters that follow, you should find ail that you need to know
in order to write first-rate computer programs yourself. The present
chapter introduces you to the Macintosh environment and Macintosh
Pascal. If you are already familiar with the mouse, pulldown menus, icons,
and overlapping windows, you may want to skip ahead.

1.1 e Starting Up
and Using the
Mouse

The on/off switch for the Macintosh is located on the back of the machine
on the left side as you face the screen. When you turn it on, the screen
displays an image, or icon, of a disk with a question mark flashing. Below
the screen under the left side of the front is a knob which controls the
brightness of the screen; you may want to adjust the brightness before
continuing. The Macintosh Pascal disk contains the system information
needed by the machine, as well as the Pascal interpreter. Insert the disk
label side up, metal end first. You can hear it snap into place.

When the machine has finished reading the system information it
needs, the screen displays an icon of a disk with the disk name
underneath it in the upper right corner of the screen, and the trash icon
underneath it in the upper right corner of the screen, and the trash icon
(a tiny garbage can) in the lower right corner. The command menus
appear across the top of the screen. There is also a pointer somewhere
on the screen. The location of the pointer is controlled by the mouse.

The mouse is the primary means of communicating with the
machine. There are four ways of signaling with it.

To locate the pointer, roll the mouse on any flat surface. The pointer follows
the movement of the mouse. If you are too close to the edge of a table, just
pick up the mouse and move it to a new starting point.

To click the mouse, press the button on top of the mouse and then release.
To click an icon or a window, locate the pointer on it and click the mouse.
Clicking an icon or a window causes it to become active. The active item is
highlighted to djstinguish it. The commands that you choose from the menu
will act on whichever item is active.

To double-click, press and release the mouse button twice quickly.

The drag the mouse, move the pointer to the desired location, push the
button down, and hold it down while you move the pointer to the new
location, then release the button.
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Anicon can be dragged to a new position by locating the pointer on
the icon and then dragging it to the new location. The icon will stick with
the pointer until you release the mouse button.

The pointer, or cursor, is not always an arrow. It is displayed as an
Ibeam when choosing edit locations, a plus sign when a program is
running, a wristwatch when the computer is busy and you must wait.
Regardless of the cursor’s chape, its location is always controlled by the
mouse.

Each menus across the top of the screen offers several selections. To
read the selections on any one of them, locate the pointer on the menu
name, press the mouse button and hold it down. The selections displayed
in bold type are available. To choose one, drag the pointer down to your
choice and then release the mouse button. Notice that some of the
selections are followed by a symbol and a letter. These represent
keyboard commands that can be substituted for the menu and mouse.
The Macintosh screen is shown in Fig. 1.1 with the file menu
highlighted.

To open a disk or file, either choose Open from the File menu or
double-click the icon. In order for an item to be opened it must be the
active item,; if the one you want to open is not the highlighted item it can
be activated by clicking it. Opening an item causes its contents to be

1.2 e Menus,
Windows, and
Icons

% WACH Fdit  Uiew

Get Info 3

Pascal |

Speciai

Figure 1.1 @ File menu
on Macintosh screen
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displayed on the screen in a window. The display will be by Icon, by Name,
by Date, by Size, or by Kind depending on which view was last selected for
that file from the View menu. To close the window, either choose Close
from the File menu or click the white square on the left side of the
title bar.

It is not necessary to close one window before opening another;
more than one can be displayed at a time. You can tell which window is
the active one by looking at the title bar; it will be lined on the active file
and clear on the others. When the windows overlap, the active one will
always appear at the front. To activate a different window, click anywhere
within it.

You may need to rearrange the windows on the screen to suit your
needs. To move the whole window, drag it by its title bar. If you want to
make it larger or smaller, drag from the size box in the lower right corner.
The arrows on the bottom and right borders are for scrolling the screen.
Move the pointer to the arrow, then press and hold the mouse button to
get the view that you need. You can also change the view by clicking
anywhere on the bottom or right border or by dragging the white square
on either of these borders to a new position. The position of the square on
the border indicates the position of the view in relation to the total
document.

The icons displayed in the windows and on the screen tell you what
kind of information is contained. Files are represented by file folders,
documents by a sheet of paper, garbage by a trash barrel, and so on.
These sets of information can be relocated by dragging the icon from
place to place. Documents can be moved from folder to folder or disk to
folder; files can be moved to the trash barrel, all the documents
contained within go with it. They will remain in the trash barrel and can be
retrieved until you choose Empy Trash from the Special menu. Once you
have emptied the trash, they are gone for good. If you want to save a
particular document, drag it to the disk window or to another folder
before you move the file folder to the trash. When you have finished
moving icons around, choose Clean Up from the Special menu and the
macine will straighten out your icon display.

To move information to a different disk, make sure its icon is
displayed in a window, then activate the current disk icon and choose
Eject from the File menu. Insert the new disk and drag the icon you want
to save to the new disk icon. The machine will direct you from that point.
A copy is always left behind when a file or document is moved to a new
disk.

These filing activities are all part of the Finder, a control system
provided by the Macintosh which makes it easy for you to keep your work
in order. The information presented here will get you started; for more
detailed information on the Finder you should refer to the Macintosh
manual.
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Figure 1.2 presents a simple Pascal program. This program reads a 1.3 @ Entering,
Fahrenheit temperature, computes its Celsius equivalent and prints the Editing, and
result. : . Running a

We will discuss the structure of a program in detail in the next Program
chapter. The purpose of the present chapter is to introduce the working
environment and the process of entering and running a Pascal program
on the Macintosh. You may choose to enter this program into your
computer to get a feel for the system. As you enter it, be aware that every
detail is important; correct punctuation and spelling are not just niceties
here, they are absolute necessities.

When you open a Macintosh Pascal file, you are presented with
three windows: Untitled, Text, and Drawing (see Fig. 1.3).

The Untitled window should show as the active one. When you type
in a program, that is where it appears. Drag the window out to the right to
give.yourself a better view while you are typing. Type the program just as
itis printed in Fig. 1.3, but be prepared for some surprises. The entries are
automatically formatted as you go along. Certain words become boldface
lowercase print. These are keywords and will be discussed in the next
chapter. Alignment is performed as soon as each statement is accepted
by the machine. Some line changes are automatic, but you can use the
carriage return to create blank lines and to put the comment (the
sentence enclosed by curly brackets) on a line by itself.

% File Edit Search Run IWindows k

Figure 1.2 ® Program

Temperature Temperature

program Temperature;

{ == This program comverts 3 Fabeenfieit termper sture do its Celsius equivalent }

var
F : Integer;
C :Real;

begin

write('ENTER & F AHREMHEIT TEMFPERATURE : *J;

ReadLniF);

C=(5/9) *(F-32);

Writeln;

writeLn(F : 2, ' DEGREES F AHREMHEIT 15 EQUAL TO', © 0 3 o 1, ' DEGREES CELSILS. ")
end.

EI==——-——— Text
ENTER A FAHREMHEIT TEMFERARTURE &9

£9 DEGREES FAHREMHEIT % EQUAL 7O 20.6 DEGREES CELSIUZ.
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Figure 1.3 @ The three
windows on the
Macintosh screen

% File Edit Search Run Windows R

[

O=—— Unlitled =="nrnuno Texnt

End Drawing

<@

There are several options available for making changes and
corrections. The simplest way to correct a mistake is to use the
Backspace key. The Backspace key will erase as it goes and new data can
be entered immediately.

Another tool available is the Edit menu. The cursor location tells the
machine where an operation is to be performed, and the Edit menu tells it
what is to be done.

You can change the location of the cursor by using the mouse to
move the Ibeam to the desired location and then clicking or dragging.
Clicking selects a location; dragging selects a section of text, which
becomes highlighted. A whole word can be highlighted by double-clicking
it. To highlight several words or several lines of text at once, place the
Ibeam at one end of the section and drag directly to the other end of the
section; everything between will become highlighted. Pressing the
Backspace key will clear the entire highlighted area. Entering new text
will also clear the highlighted area; the new text will replace it.

Once you have placed the cursor, you have several choices
available to you from the Edit menu. You can Clear the highlighted area
from your program, Copy it onto the clipboard, or Cut it out of its present
location and Paste it into a new spot. When you Cut or Copy, the text is
put onto the clipboard, replacing whatever was there before.
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If you have any doubt about what the clipboard contains, go to the
Windows menu and select Clipboard. This causes the clipboard window
to be displayed on the screen, allowing you to view the contents. The
Windows menu also offers the choice Type Size. Choosing small type
allows more of the program to be displayed at one time.

Once the program is entered correctly, it is important to save it. The
File menu has a Save As command and a Save command. You choose
Save As first to name your program. When the dialog screen appears,
type the name of your program and then click the Save button. If you
make changes later, choose Save to have the changes saved on the disk.
Up until you Quit the program you have the option of reverting to the last
saved version; choose Revert from the File menu to discard the most
recent changes.

Always save your program before you run it. Don’t take a chance on
losing it; this can happen if something in the program causes a problem
for the machine.

There is one more thing to think about before running a program.
Consider the location of the program’s output. You will probably want to
activate the Text window for this program. The output is written to the
Text window whether it is active or not; the purpose of activating it is to
make it visible. If you did not cover it completely when you enlarged your
program window, you can activate it by clicking in the visible portion. If it
is completely covered, either shrink the program window or go to the
Windows menu and select Text. ’

Now choose Go from the Run menu to start the program. When you
see Pause appear on the menu line, the machine is waiting for data from
the keyboard in order to continue. You have the option of choosing Halt
from the Pause menu or entering the needed data. For the example
program, the data needed is an integer representing a Fahrenheit
temperature. As soon as you enter an integer number followed by a space
or carriage return, the program will continue its run. Step will run one line
of the program at a time. The finger in the left margin points to the next
step that is to be executed. Step-Step activates the pointer to show which
step is being executed, but does not stop after each statement.

There comes a time when a printed copy of the program or the
output is needed. To print only the program, activate the program
window, turn on the printer, and choose Print from the File menu. This
will cause a dialog box to appear requesting certain instructions: the
quality of print, the page range, the number of copies, and the type of
paper being used. Once these choices have been made, click the OK box
and printing will begin. To print the output of the program, you must
follow the instructions for printing the contents of the screen. Hold down
the “Command” key (the wide key to the left of the space bar) and the
“Shift” key while you type the number “4.” This will cause the contents of
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1.4 O Practice

the active window to be printed. If the “Caps Lock” key is also down, the
contents of the whole screen will be printed.

The information in this chapter will get you started using your
Macintosh and Macintosh Pascal; as you continue to use the computer,
refer to the menu commands summarized in Appendix A.

Operting

#e

M)

The best way to become proficient at using the Macintosh is, of course, to
sit down and use it. This section should be read at the computer as you
experiment with some of the options. If the disk you are using has
previously been used by someone else, there may be some differences
from what is described below. Do the best you can.

Experiment first with opening and closing the disk icon and the trash
barrel. Choose different Views and note the arrangement of the
information with each view. Next, open the system folder. Inside the
system folder there should be an icon marked Empty Folder. Duplicate
the empty folder. What is the name given to the new folder?

A new folder icon should have appeared next to the original and should
be labeled Copy of Empty Folder. Once a duplicate folder has been
created, it can be moved onto another window or into a folder or disk.
The name can be edited whenever the icon is displayed. Move the folder
to the disk window and then choose Clean Up from the Special menu to
keep the desktop neat. Edit the name on the folder so that you can use it
to store your work. Do this before you continue.

Now that you have a folder for storing programs, it would be nice to have
something to put in it. Entering the text of a program may not be the most
enjoyable part of the programming process, but it is important that you
become proficient at it. Fortunately, Macintosh Pascal assists you in this
operation. Open the Macintosh Pascal application now and enter the
example program Temperature. Run it through a Check and make
whatever corrections are required. Do not save it yet. Choose Quit from
the File menu. What happens?

The Macintosh usually sounds a warning when you may be making a
mistake or when your intentions are unclear. The dialog box that appers
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on the screen requires your attention before you can continue. It is a
reminder that you have not saved your program. Choose Save. You will
be asked for a name for your document; enter the name Temperature,
then click the Save button in the dialog box. What happens?

Now the computer can act on your original Quit command; it will return
to the Finder. When returning to the Finder, whichever windows were
open when you left the Finder will still be open. Find the icon for the
program you just entered and saved and put it into your folder. You can
do that either by dragging the document icon to the folder icon, or by
dragging the document icon onto the folder window.

Open program Temperature. Now close the windows using the Close
choice from the File menu. Clicking the white box on the menu bar does
not accomplish what is desired here; when you are in the Pascal
application, clicking the disappear box does make the window disappear
from the screen, but it does not close the file. Choosing Close closes the
present program but does not return to the Finder. Note that the disk icon
and the trash barrel are not on the screen. The Pascal application is still
open. Check the File menu now. What are the new choices available?

Two additional choices are now available, New and Open. Choosing New
creates a blank program window for a new program. Choosing Open puts
up a dialog box listing the available files. We need program Temperature
again. There are two ways to open it. What are they?

The dialog gox shows the names of the available files along with an Open
choice, a Cancel choice, and an Eject choice. A file can be opened by
clicking the file name and then the Open button, or by double-clicking the
file name.

Run program Temperature at least once using Go. Run it again by
holding down the fan key and typing “G.” Note that the Pause menu lights
up when the computer needs data from the keyboard. Now Step through
the program; either choose Step or use the fan key and “S.” There are
several things to note as you step through.

1. The finger points to the line that is to be executed next; that line is
executed when you choose any Run command.
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2. The Pause menu does not light up when you are using Step;
however, note that the cursor appears on the text screen when
data is needed.

3. If you try to advance beyond the Read statement without
entering needed data, a warning is sounded.

Using the Search menu, change All Occurrences of “F” to “FTemp” and
“C” to “CTemp” everywhere in the program. Do not Save. Run the edited
version. How does the output change?

All Occurrences means exactly what it says. The “F” in the word
“Fahrenheit” and the “C” in the word “Celsius” are replaced with
“FTemp” and “CTemp” producing a very strange sentence.

Revert to the previous version of the program. Print the program
using the Print choice from the File menu. Run the program and print the
output screen.

Save the program under a different title (use Save As). Return to the
Finder. The right side of the title bar shows the Space Available on the
disk. Note the amount. Now, move the new version of the program to the
trash barrel. How much does the space available change? Empty the
trash. Again, how much does the space available change?

Moving a file to the trash barrel does not remove it from the disk;
therefore, the space available on the disk does not change. However,
once the trash has been emptied, the space is available for other use.
Removing program Temperature creates 1K more of disk space. Notice
that when you choose Empty Trash, no warning beep is sounded. Always
be aware of what is in the trash barrel before you empty it. When in doubt,
open the window and check. You will be warned if you try to empty
something the computer needs, such as the system folder.

Open the Control Panel (keep looking, it’s there somewhere) and
adjust the speaker volume by dragging the knob up or down. Open
program Temperature and change the Type Size to small. Now quit the
application, eject the disk, and turn off the machine. Restart the disk.
What happened to the speaker volume? What happened to the type

size?
o000
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Each time the Pascal application is opened, the default conditions are
active. Changes are maintained when going from one program to
another, but returning to the Finder deactivates them. The system
changes, on the other hand, which are set at the Control Panel, are
recorded on the disk and remain active until changed again.

Try the review exercises below. You should be off and running now.

Fill in the Blanks

1. A file can be opened by choosing_______ from the
menu, or by the file icon.

2. Clicking the causes the window to disappear.

3. Toname afileechoose __ from the

4. To change the name of a file, the must be
displayed.

5. To shrink or stretch a window, drag from the
corner.

6. To print the contents of a window as displayed on the screen, hold
downthe _ keyandthe______ key and press the
number

7. The control panel is found in the menu.

8. When the Macintosh application is active, the contents of the

clipboard can by displayed by choosing
from the menu.

True or False

1.
2.

3.

wm

Choosing GO from the RUN menu causes the cursor to move.

Some menu selections are in boldface print, some in light print. The
lighter selections must be double-clicked.

If you type “help” on the screen, the computer will tell you what
mistake you have just made.

. You cannot see through a Macintosh window.
. Macintosh Pascal is easy to use.
. In order to erase the letter you just typed, press the Backspace

key.

. The Command key is marked “C.”
. Saving the file causes the contents of the screen to be copied to the

internal memory of the Macintosh.

. Instead of choosing from the RUN menu, you can type “run.”
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10. The contents of the trash barrel can never be retrieved.

In order for you to check your own weak spots, the answers for the
True/False and Fill in the Blanks exercises are given in the following
paragraphs. If you feel reasonably comfortable with your results,
continue on. As you begin writing and running your own programs, you'll
get plenty of practice using the Macintosh.

There are two ways to open a file. It can be opened by activating the
icon with a single click and then choosing OPEN from the FILE menu or by
DOUBLE-CLICKING the icon.

When a window is active, the title bar at the top of the window shows
a set of horizontal lines. The lines are interrupted on the left side by a
small white box. Clicking the WHITE BOX ON THE LEFT SIDE OF THE
TITLE BAR causes the window to disappear.

To name a file, choose SAVE AS from the FILE menu. This causes a
dialog box to appear. Type the name into the space indicated. This causes
the computer to set aside a location on the disk for that particular file and
to associate the given name with that location. To change the name later,
go to the window containing the FILE ICON. Activate the icon by clicking
it, then edit the name using the cursor to erase the old name or make
corrections.

A window can be stretched or shrunk by dragging the LOWER
RIGHT corner to a new location.

Itis possible to print the contents of a single window or the contents
of the whole Macintosh screen. To print only the active window, hold
down the SHIFT key and the COMMAND key and type the number “4.” To
print the whole screen, first press the Caps Lock key, and then the fn,
Shift, and 4.

At the top of the screen, in addition to the menu names, there is an
apple. Press and hold on the apple and a list of choices including the
control panel is displayed.

When using the Finder application, the clipboard can be viewed by
choosing Show Clipboard from the Edit menu. In the Macintosh Pascal
application, that choice is not available in the Edit menu. However, there
is a choice labeled CLIPBOARD under the WINDOWS menu, which causes
the contents of the clipboard to be displayed.

Let’s take a look at the True/False questions. Number 4 is obviously
true. Number 6 is also true. As far as number 5 goes, to each his own. The
others are false.

The movement of the cursor is always controlled by the mouse.
However, the form that the cursor takes depends on what activities are
being performed. When a program is running, the cursor appears as a
plus sign.

Some menu choices appear in boldface print, others are light. Orily
those in boldface print are available. Trying to choose one that is in light
print has no effect.
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If you type the word “help” on the screen, all you will get is the word
“help” on the screen.

The Command key is located at the bottom of the keyboard to the
left of the space bar and is marked with the picture of a fan.

When a file is Saved, it is written to the disk.

Typing “run” at the keyboard does not cause a program to run.
However, a program run can be initiated by holding the Command key
down and typing “G” at the keyboard. Command “S” will run one line of
the program; this may be a little quicker than using the mouse and menu if
you are running several lines.

Don’t empty the trash until you are sure you do not need the
contents. Until it is emptied, you can retrieve whatever is there by
dragging the icon back to the screen. However, once the can is emptied, it
is gone for good.

15 O

1.1 Entering a Program

Entering the text of a program is a task in itself. It is important that you
become proficient at it. Fortunately, Macintosh Pascal gives you a good
deal of assistance. The following program is to be entered word for word.
If you make mistakes, they must be corrected. Once the program is
entered, run it through Check and Go.

program WriteName;
var
Name : string;
begin
WriteLn(‘What is your name? ");
ReadLn(Name);
WriteLn(‘Thank you, ’,Name, ‘.")
end.

Note: If you enter this program correctly, the text screen will first
show a request for your name. Enter your name by a return. The
response line should appear, properly punctuated with a comma
following the “Thank you” and a period at the end.

1.2 Running a Program
Enter the following program and then run it several times, successively
using the following values as inputs for I:

0 5 25 25000 2525
Can you explain the outputs?

varmng

2565
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program Square;
var
I : Integer;
begin
Read(D);
Write(1 * )
end.

1.3 Read and ReadLn

When a Read statement is encountered in a program run, the cursor
begins flashing on the text screen, indicating that data is expected. If the
statement is a ReadLn rather than a Read, the run does no continue until
areturn is encountered. Change the Read in the program of the previous
exercise to ReadLn and run the program again with the same set of input
values. When you enter the 25.25 what happens to the decimal
portion?

1.4 Write and WriteLn

Write and WriteLn are related in a way similar to Read and ReadLn. With
Write, the data is written to the screen, and then any further data is
continued on the same line. With WriteLn, new data is written to a new
line. Enter the following program and then try to find ways to improve the
output.

program NewYear;
begin
‘Write('HAPPY NEW YEAR));
Write(‘HAPPY NEW YEAR")
end

1.5 Calculations
Enter the following program:

program Calculate;
var
X : Integer;
Y : Real;
begin
Write(‘Enter an integer number: *);
ReadLn(X);
Write(‘Enter a real number: *);
ReadLn(Y);
WriteLn((X + Y) : 4: 1);
WriteLn((X-Y) : 4 : 1);
WriteLn(X*Y) : 4: 1);
WriteLn((X/Y):4:1)
end.
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This program s a little trickier to enter than the previous one. Watch
out! The : 4 indicates that the value of the expression in parentheses shall
be written using not less than 4 spaces. The : 1 indicates that 1 decimal
place will be displayed . Using the values given below as inputs, make
whatever changes are necessary to ensure that the output appears in a
column that is right justified; that is, the right hand edge must be even.
Here are the values:

X= 2 Y= 40

X=10 Y = 30.0
X =555 Y =333



Chapter 2

The following programming
application demonstrates how a simple Pascal program is written. [t gives
an example of the steps from problem to printout. With the information
contained in this chapter, you will be able to write some simple programs
of your own.

You have an opinion on what temperature is comfortable for a study
room. You may think of the temperature in degrees Fahrenheit and might
find it useful to relate room comfort to degrees Celsius. When you think of
a particular Celsius temperature as being related to comfort, instead of
thinking of it only as the equivalent of some Fahrenheit temperature, it
becomes more meaningful. To do this, let us consider a simple program
to display three temperatures along with their comfort levels. The
problem is defined as follows:

to read in 3 Fahrenheit temperatures defined by the user as too cold,
comfortable, and too hot,

to compute the Celsius equivalent of each of them, using the formula
C=(5/9)(F-32),
to display the results with the following format:

TEMPERATURE SUMMARY

F C
? Too Cold ?
? Comfortable ?
/4 Too Hot ?

The question marks stand for the given temperatures.

21
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2 Writing Simple Programs

2.1 ® The
Concept of
an Algorithm

Of all the topics discussed in this book, the most fundamental is the
concept of an algorithm. The rigor demanded by a computer algorithm is
the essence of programming, no matter which special language you are
working in. Let’s quickly review the properties of an algorithm, for this
gives us the key to all that is taken up in later pages.

Generally, an algorithm is a sequence of instructions given to solve
some problem. Any algorithm must have the following characteristics:

1. It must be organized properly. An algorithm reflects some
sequence of instructions carried out in the real world. Accord-
ingly, the instructions must be arranged in some meaningful way
in order to solve the problem at hand.

2. It must go step by step. Each instruction in the algorithm must be
some form of imperative statement, or command, to carry out a
given step in the problem solution. After each step, the next step
in the solution must be unambiguous.

3. It must be precise. The instructions given in an algorithm can
leave no room for ambiguity. Thus it must be possible to
interpret the instructions in only one way.

4. It must make the data explicit. Each item we choose to include in
our algorithm must be clearly identified. For example, if an
algorithm has something to do with temperatures, and these are
calculated during the course of the algorithm, then these items
need to be described explicitly.

5. It must contain no irrelevant information. There can be no loose
ends, no extraneous instructions, no frills. The algorithm must
state only the relevant instructions needed to be carried out.

6. It must be correct. An algorithm is always directed toward its
single goal—to establish results that will be known upon its
completion. The results must be exactly what you want.

All of these features are things that we often take for granted. In an
algorithm, we must be rigorous to the last detail.

For our problem we first need to request some data, the three
temperatures, from the user. When the machine reads these three
numbers, it assigns them to particular variables, so we must have a name
or identifier for each one. The program is easier to read if the names are
descriptive of the value being entered, so we have chosen to use
TooCold, Comfortable, and TooHot.

Once we have the three values, we can apply our formula to each of
them in turn; we assign each temperature to F, calculate the Celsius
equivalent, and store the result as C. Each time we assign a new value to F
or C, the assignment causes the previous value to be discarded, so each
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value must be printed before the next one is calculated. Before we print
the temperatures, however, we want to print a title and heading.

When all of these steps are put into the proper order, we arrive at
the algorithm shown in Fig. 2.1.

The corresponding program is shown as Fig. 2.2. Notice here that
the Celsius temperature required for the output is a two-digit integer;
however, our formula returns a decimal number, so we have added one
more step to give us the type of number that we need for our
summary.

C := Round(Real(C);

The additional step creates a need for an identifier for the intermediate
value of C. Since it has to be declared as a Real number we have chosen to
name it RealC. We will explain more details as we proceed.

Now we have a working model of a typical Pascal program. As you have
probably already observed, the writing of programs requires that you
know a number of sometimes odd conventions. Let’s start by examining
the major components of our example program.

program TemperatureSummary;

2.2 ® General
Program Structure

-- declarations
begin
-- statements
end.
Definitions: Figure 2.1
TooCold : degrees Fahrenheit entered by user
Comfortable: degrees Fahrenheit entered by user
TooHot : degrees Fahrenheit entered by user

F: Fahrenheit temperature
C: Celsius temperature
Algorithm:
Request degrees Fahrenheit for each comfort level
Read temperatures for TooCold, Comfortable, and TooHot
Write headings
For each temperature do the following:
set F to temperature
apply formula C = (5/9)(F-32)
write: F, comfort level, C
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All programs begin with the word program followed by the name of
the program, in this case TemperatureSummary.

Following the program heading are definitions for all of the objects
in a program. Each definition is called a declaration. In Pascal, this rule
must be followed strictly. Every name used by the programmer must be
defined in a declaration. For example, “F” is the name that stands for a

Figure 2.2 ® Program program TemperatureSummary;
TemperatureSummary  { -- This program reads 3 Fahrenheit temperatures entered by the user, }
{ -- calculates the Celsius equivalents, and prints the results. }

var
TooCold, Comfortable, TooHot : Integer;
F,C : Integer;
RealC : Real;

begin
{ -- Request temperatures }
Write(‘Enter 3 Fahrenheit temperatures: too cold, comfortable, too hot: );

{ -- Read Fahrenheit temperatures }
ReadLn(TooCold, Comfortable, TooHot);
{ -- Write headings }
WriteLn;
WriteLn;
WriteLn(‘TEMPERATURE SUMMARY");
WriteLn(‘----=-==s=meeenmcnanas ;
WriteLn(* F C?;

{ -- Calculate celsius equivalents and write results }

F := TooCold;

RealC := (5/9) * (F - 32);

C := Round(RealC);

WriteLn;

WriteLn(F : 2, Too Cold ’, C : 2);

F := Comfortable;

RealC == (5/9) * (F - 32);

C = Round(RealC);

WriteLn;

WriteLn(F : 2, Comfortable ’, C : 2);

F := TooHot;

RealC .= (5/9) * (F - 32);

C := Round(RealC);

WriteLn;

WriteLn(F : 2, Too Hot’, C : 2);
end.
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Fig. 2.2 continued

E=—= Tent =
Enter 3 Fahrenheit temperatures: [

too cold, comfortable, too hot:
60 60 72

TEMPERATURE SUMMARY

F C
1] Too Cold 16
69 Comfortable 21

78 Too Hot 26

2ka]

Fahrenheit temperature. This name must be declared, as in
F: Integer;

This declaration means that the name F will hold integer values during
the course of the algorithm portion of the program. The three
temperatures entered by the reader; TooCold, Comfortable, and TooHot
will also hold integer values. We want to display an integer value for the
Celsius temperature also; that must be declared. However, when we
apply the formula, C = (5 / 9)(F — 32), the calculation will produce a real
number; therefore, we must assign the result to a variable that has been
declared as Real, as in

RealC : Real;

Next we come to the algorithm portion of the program. An algorithm
is written as a series of statements. There are several kinds of statements
in Pascal. Each of them specifies some action to be carried out by the
computer. For example, consider the assignment statement,

RealC := (5 / 9) * (F - 32)

The symbol ;= is read as “becomes”; it assigns the value of the
expression on the right to the variable on the left. During the course of the
program, F takes on three different values. When a new value is assigned
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to the identifier, it replaces the existing one, which is discarded.
Therefore, we print out the F and C values in each case before starting the
next calculation.

Other statements in Pascal cause a series of actions to be
performed. For instance the statement

WriteLn(F : 2, Comfortable ’, C:2)

is actually a procedure call. It calls the procedure WriteLn, which causes
the machine to print the integer value for F using two digits, print the
character string enclosed by the parentheses, print the integer value for
C using two digits, and then move to the beginning of the next line.

A program always ends with the word end followed by a period.

All of these points will be taken up in greater detail in later chapters.
For the remainder of this chapter, however, let's take a closer look at the
individual components of a program.

2.3 ® The Units
of a Pascal
Program

At the most elementary level, a Pascal program consists of a sequence of
symbols. The possible symbols are listed in Table 2.1. The arrangement
of symbols is subject to numerous and sometimes complex conventions
that you will have to learn as you go along. Here we pin down a few of the
more primitive conventions, including the rules for writing names,
numbers, character strings, and comments.

Identifiers

An identifier is a name created by the programmer. It consists of one or
more letters, digits, or underscores, but the first character must always
be a letter. An identifier can be up to 255 characters long, but cannot
contain any spaces. The identifiers we have used are

F C TooCold Comfortable TooHot RealC

Macintosh Pascal accepts the use of the underscore in an identifier,
therefore we can, if we choose, use

TOO_HOT
instead of
TooHot

In identifiers, uppercase and lowercase letters are treated as being
equivalent, which means that the identifier

COMFORTABLE
is the same as

Comfortable
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Keywords

Table 2.1 also lists the 38 keywords in Pascal. A keyword is a special
identifier that tells the computer what to do. For example, the keyword
program introduces a program. Other keywords have more ubiquitous
meanings. For example, the keyword end marks the end of something—
the end of a sequence of statements, for instance, or the end of the
program.

You don’t have to memorize all the keywords. The important point
is that each has a specific role. Furthermore, the keywords in Pascal are
said to be “reserved,” meaning that you may not use them as identifiers in
your program. For example, if we wished, we could change the name
TooCold to Chilly, but we could not change it to Program or Array
because these are reserved.

Table 2.4 ® Macintosh Pascal Symbols

Digits
0123456172829

Letters
abcdef ghij k1l m
nopqrstuvwxyz
ABCDEFGHI JKLM
NOPQRSTUVWXYZ
Special Symbols
+-*/ =<>[1" () @5
, L Ao=<=<>=.. { }
Keywords
and else label packed until
array end procedure  uses
program
mod var
begin file record
for nil repeat while
case function not with
const set
goto of string
div or
do if otherwise then
downto in to

type
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Numbers
Suppose you wish to compute the number of feet to the scene of a crime,
or an amount of money embezzled in a series of bank transactions.
Pascal, like any other programming language, has a rather fixed set of
conventions for writing numbers.

The first kind of number you can write is an integer, which means a
whole number. An integer is represented by a sequence of digits, possibly
preceded by a plus or a minus sign:

0 10
1776 +10
100000 —10

Negative numbers can be used to represent things like a temperature of
minus 10 degrees or a bank balance that is “in the red.”

The second kind of number you can write in Pascal is a real number.
Areal number must have either a decimal point, a letter “E” followed by a
scale factor (which means “times ten to the power of”), or both. For
example, you may write the numbers,

12.34
1234E—2
0.1234E2
0.1234E+2

both of which stand for the same real number.

The E notation (often called scientific notation or floating point
notation) is especially useful for very large or very small numbers, which
might arise if you are trying to calculate the distance between two planets
or the weight of a molecule. Instead of writing,

123000000000000
0.0000000000000456

you can write,

1.23E+14
4.56E—14

This saves you from counting zeros to find how large or small a number
is.

These are the only conventions you can use for writing numbers. Be
careful, for as much as you would like, you cannot write numbers like the
following:

2. { you must write 2.0 }
3 { you must write 0.3 }
1,000 { you must write 1000 }

$123 { you must write 123 }
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With both integer and real numbers there is a limit to the number of
digits that the machine will accept. If you are using an integer greater than
32,767 or less than —32,767 it must be declared as LongInt instead of
Integer. Real numbers are limited to 8 decimal digits; however if greater
accuracy is needed, they can be declared as Double or Extended.
Whatever number you have in mind, you must declare it as either an
integer, long integer, real, double, or extended number. Normally you use
integers to represent thing you can count (the number of degrees
Fahrenheit or the scheduled time of a train arrival, for example) and real
numbers to represent things you measure or calculate that cannot be
determined exactly (the number of feet to the scene of a crime or the
result of a division problem, for example).

Character Strings

Often when you use a computer program, you want your program to
print messages telling you what is going on. You can do this with
character strings, such as

‘Enter a Fahrenheit temperature:’

To print a character string, you simply include it in a Write or WriteLn
statement, just like

WriteLn(‘TEMPERATURE SUMMARY")

in our example program.

A character string consists of a sequence of characters enclosed by
single quotes. You might have expected that a character string would be
enclosed by double quotation marks(”); so be careful, as a single
quotation mark, an apostrophe(”), must be used.

Any characters that the computer recognizes can be put into a
character string, even such characters as $ and %. If you would like to
have an apostrophe itself as part of a character string, just type two
apostrophes in a row, and it will output as a single apostrophe. Thus we
may have

‘THE BOY”’S HAIR IS BROWN’

‘NOTE THE PAIR OF SINGLE QUOTES ABOVE’
‘STRINGS MAY CONTAIN SPECIAL CHARACTERS’
‘LIKE $ AND %’

‘as well as lowercase letters’

Comments

One of the most useful features of programming languages is the ability to
annotate your program with comments. Completely ignored by the
computer, comments are there entirely for the enlightenment of a human
reader. For example, in the sequence
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{ -- Calculate Celsius equivalents and write results }
F := TooCold;

RealC == (5/9) * (F - 32);

C := Round(RealC);

WriteLn;

WriteLn(‘F : 1 TooCold ’,C:1);

the first line is a comment.

A comment consists of any sequence of characters enclosed by
curly braces. The text of the comment may include anything you like
except a right curly brace (}).

{ -- If you include a carriage return in your comment, }
{ -- a right brace will be automatically entered to end the line, }
{ -- and a left brace will be entered at the beginning of the next line. }

Comments may be placed between lines of the program or at the
end of lines. If they are entered within a line of program text, they will be
moved to the end of the line.

As far as running the program is concerned, the comment will have
no effect and will be treated just as if it were a blank space.

If you, choose, you can enclose comments with the symbols (* and
*) instead of curly braces; for example,

(* -- Write headings *)

No matter which symbols you use, be sure to close off each comment
with its terminating *) or }. If you do not, all the program text following the
comment will be treated as part of the comment itself.

2.4 ® Syntax
Issues

Much of the formatting of a program is done for you in Macintosh Pascal.
Each statement is started on a new line. Indenting is* performed
automatically. You do have the use of blank lines and spaces at your
disposal, however. For instance, it is much easier to read,

{ -- Request temperatures }
Write(‘Enter 3 fahrenheit temperatures: *);
ReadLn(TooCold, Comfortable, TooHot);
{ -- Write headings }
WriteLn;
WriteLn;

than

{Request temperatures}

Write(‘Enter 3 fahrenheit temperatures:’);
ReadLn(TooCold,Comfortable, TooHot);
{Write headings}

WriteLn;

WriteLn;



Practice—Syntax 31

The only difference between the two examples is the use of spacing. The
computer will ignore blank spaces and blank lines, but the human reader
will not. In fact, the proper spacing of programs can go a long way in
making your intended purpose clear.

There are a few restrictions on the placing of blank spaces and blank
lines. These restrictions need not concern you very much, as they are
reasonably obvious. For example, you may not put blank spaces between
the characters of an identifier or between the : and the = of a :=. And, of
course, at least one blank must be inserted between adjacent words (for
example, between program and the program name).

Finally, the end of a line is treated as if it were a blank space, at least
as far as the computer is concerned. All of these rules follow common
intuition, and generally speaking, you may insert blank spaces and blank
lines wherever convenient.

Now we come to the rules for the placement of semicolons. The first
rule is simple. A semicolon is required at the end of a program heading, as
in:

program TemperatureSummary;

As we shall see later, the same rule applies to procedure and function
headings.

The second rule is just as simple, but a bit more embracing: a
semicolon is required after each declaration. For example, a semicolon is
required after the variable declaration,

RealC : Real;
and after each declaration of a list of variables, as in
TooCold, Comfortable, TooHot : Integer;

Things begin to get a bit more sticky when we come to the algorithm
part of a program. A semicolon must be placed between the statements in
a sequence of statements. In effect, in a simple sequence of statements a
semicolon is required after each statement except the last. When we get
to structured statements, there will be more details to remember, but this
will suffice for now. If you have any doubts about the placement of
semicolons, refer to Appendix B, which summarizes the formation rules
for writing programs in Macintosh Pascal.

Following the practice section, there are suggestions for some
programs that you should be able to write with the information covered
so far.

2.5 ® Practice

Consider the program shown in Fig. 2.3, which prints a replica of the letter
H. Certain properties of this program are shared by all other Pascal
programs, short or long.

i
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Figure 2.3 ® Program program BigH;

BigH { -- This program prints a replica of the letter H, }
{ -- printed with 14 lines of H’s. }
begin

WriteLn(‘HH HH");
WriteLn("HH HH");
WriteLn(‘HH HH");
WriteLn(‘HH HH");
WriteLn(‘HH HH");
WriteLn(‘HH HH");
WriteLn(‘tHH<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>